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Learning Objectives 

 Create View Filters and View Templates 

 Using a Selection Set to create a View Filter 

 Assigning Vs. Applying View Templates to Views  

 Using Temporary View Properties 

 

Description 

Using View filters inside of Revit will allow you to control both the visibility and graphics of the elements 
included in the filter.  Filters can either be created from a conditional format or from a selection set.  
Once filters are created, knowing how to assign them in View Templates and assign View Templates to 
views are the key to create standardization in your project.  Join me as we discuss both new and old 
features of View Filters and View Templates to control your graphics and visibility.  

 

Your AU Expert 

Mike Massey graduated from Texas A&M University with a degree in Architecture. He has 25 plus years 
of experience working in the AEC industry. He has worked on various types of projects including 
residential, commercial, retail, educational, and healthcare. Mike’s roles in architectural firms have 
ranged from drafter, designer, project architect, project manager, CADD Manager, and Director of I.T.  

Since joining Applied Software, Mike specializes in BIM implementation for architects and MEP 
engineers. In addition, Mike has been responsible for providing customer demonstrations, 
implementation, training and support for the Autodesk AEC products for architects, engineers, and 
contractors. 

Mike has spoken at various AIA functions on the benefits of BIM (Building Information Modeling), 
conducted regional CAD Camp seminars, and is a repeated speaker at Autodesk University. Mike is a 
contributing author for Autodesk Official Training Courseware. 
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Introduction 

One of the most frustrating parts of Revit is getting the visibility and graphics to appear correctly.  Revit 
has many settings users can modify that will affect the visibility or graphics.  This session will explore the 
many ways to adjust your views to look the way you want them to. 

View Filters 

Visibility/Graphics is the primary method to control the visibility or graphics of a group of elements 
inside the Revit model.  Visibility/Graphics will only change the visibility or graphics of categories in the 
current view.  Visibility/Graphics is also a tool to change the entire category; you are not able to select 
partial parts of a category.  To control partial parts of categories, a View Filter must be used. 

View Filters provide a way to override the graphic display and control the visibility of elements that 
share common properties in a view.  For example, if you need to change the line style and color for 2-
hour fire-rated walls, a view filter can be created that selects all walls in the view that have the 2-hour 
value for the Fire Rating parameter.  You can then add the filter to a view and define the visibility and 
graphics display settings (such as line style and color.  When you do this, all walls that meet the criteria 
defined in the filter will update with the appropriate visibility and graphics settings. 

View Filters are created by setting up a filter that will search desired categories that meet a particular 
rule set up by the user.  Once the View Filter is created for the project, the View Filter can be added to 
the desired views by adding them to the Visibility/Graphics for the view.   

Process of Creating View Filters 

1. Click View tab Graphics panel  (Filters). 

2. In the Filters dialog, click  (New), and enter a name for the filter.  To create a filter based on 

an existing one, in the Filters dialog, select the existing filter name, click  (Duplicate). The new 

default filter name displays in the Filters list; select it and click  (Rename) to rename it. 

3. In the Filter Name dialog, select Define rules, and click OK. 

4. Under Categories, select one or 
more categories to include in the 
filter.  The selected categories 
determine the parameters that 
are available in the Filter By lists. 
The displayed parameters are 
common to all selected 
categories.  

Tip: Use the Filter list to display categories 
that apply to selected disciplines. If you 
are editing or duplicating a filter, you can 
select Hide un-checked categories. 

 

 

 

Filters dialog 
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5. From the Filter By list, select the parameter to filter by (for example, fire rating).  If the desired 

filter parameter is not in the list, click  to view additional parameters or to create a custom 
parameter (for example, NIC [not in contract]). 

6. Select the filter operator (for example: equals). 

7. Enter a value for the filter, or select a value from the list (available for some parameter types). 

Note: If you select the Equals operator, the value that you enter must match the search value. The 
search is case-sensitive. 

8. Enter additional filter criteria as necessary. You can add up to 3 additional criteria. When you 
enter more than one filter criterion, elements must meet all criteria to be selected. 

9. Click OK when you are done creating filter criteria.  

Note:  Transfer Project Standards can be used to transfer View Filters form other projects. 

Process of Adding View Filters to Views 
You can apply multiple View Filters to the same view. 

If multiple View Filters are applied to the same view, the order in which they are listed denotes priority. 
The View Filter nearest the top of the list takes precedence. 

1. Open the Filters tab of the Visibility/Graphic Overrides dialog, using one of the following 
methods: 

 Click View tab Graphics panel  (Visibility/Graphics), and click the Filters tab. 

 Select an element in the drawing area, and click Modify | <Element> tab View panel
Override Graphics in View drop-down  Override by Filter. 

 Select an element in the drawing area, and click Modify | <Element> tab View panel
Hide in View drop-down  Hide by Filter. 

2. Click Add. 

The Filters dialog opens, which contains a list of filters created in the project. If no filters exist in the 
project, click Edit/New to create a filter. 

3. Select a filter, and click OK. 

 

 

 

 

 

 

 

 

 

Add Filter Dialog 



See What You Want to See in Revit 2016 

 
 5 

 

4. Select or clear the Visibility check box to turn visibility of the filtered object on or off. 

5. Override the Projection/Surface Lines, Patterns and/or Transparency, and Cut Lines or Patterns 
as necessary. 

6. Check the Halftone option to make filtered objects appear at halftone. 

7. Click OK or Apply to activate the filter for that view. 

Filters are view-specific. OK activates the filter and closes the dialog. Apply activates the filter and keeps 
the dialog open. 

  

 

The Filter Tab in Visibility/Graphics 
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Selection-Based Filters 

Selecting multiple elements in Revit can be done by either performing a Selection Window/Crossing or 
by pressing the CTRL key while selecting multiple elements.  If a selection needs to be re-selected once 
the elements have been released, a Selection Set can be created.  A Selection Set is a save selection of 
elements that can be re-selected by name or can be used in View Filters.   

With multiple elements selected, there is the ability to save any selection of elements and recall those 
selections at any point.  Selection Sets can be created from elements in any category or elements from 
multiple categories.  Use the following methods to select multiple elements in a project. 

If you want to… Then do this… 

Locate the desired element to select 

Move the cursor over the element in the drawing area.  Revit 
highlights the element and displays information about it in the 
status bar and in a tool tip.  If several elements are very close to or 
on top of one another, move the cursor over that area and press 
Tab until the status bar describes the desired element.  Press Shft + 
Tab to cycle through elements in reverse order. 

Select an element Click the element 

Select multiple elements Ctrl + Click each element  

Determine how many elements are 
currently selected 

Check the selection count on the status bar 

Select all elements of a particular 
type 

Select one element of the desired type, and type SA (for Select All 
Instances) 

Select all elements of a certain 
category (or categories) 

Draw a pick box around the elements and click the Filter tool on the 
Modify tab.  Select the desired categories, and click OK 

Deselect an element 
Shift + Click each element to deselect that element from a group of 
selected elements 
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To create a Selection Set 
based on selected elements 

1. Select one or more 
elements in the 
drawing area. 

2. Click Manage tab
Selection panel

 (Save). 

3. In the Save Selection 
dialog, enter a name 
for the filter. 

4. Click OK. 

 

To create a filter and add elements to the filter 

1. Click Manage tab Selection panel

 (Edit). 

2. In the Filters dialog, click New. 

3. In the Filter Name dialog, enter a name for 
the filter, click Select, and click OK to enter 
Edit Selection mode. 

 

 

 

 

 

 

 

4. On the Edit Selection Set tab Edit Selection panel, use the following tools: 

 To add elements to the filter, click  (Add to 
Selection), and then click in the drawing area to 
select elements to add. 

 To remove elements from the filter, 

click  (Remove from Selection), and then click 
in the drawing area to select elements to 
remove. 

 

 

Saving a Selection Set 

 

Naming a New Selection Filter 

 

Edit a Selection Set 
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Note: You cannot add categories to a selection-based filter. 

Note: To use a selection box to select multiple elements, first select Multiple on the Options Bar. Draw 
the selection box, then click Finish on the Options Bar. 

5. Click  (Finish Selection) to save the selected elements for the filter. 

6. Click OK in the Filters dialog. 

To use a previously saved selection filter 

1. Click Manage tab Selection panel  (Load). 

2. In the Retrieve Filters dialog, select the name of 
the filter to use. 

3. Click OK. 

 
 

To modify a previously saved selection filter 

1. Click Manage tab Selection panel  (Edit). 

2. In the Filters dialog, select a filter and click Edit. 

3. On the Edit Selection Set tab Edit Selection panel, use the following tools: 

 To add elements to the filter, click  (Add to Selection), and then click in the drawing 
area to select elements to add. 

 To remove elements from the filter, click  (Remove from Selection), and then click in 
the drawing area to select elements to remove. 

Note: You cannot add categories to a selection-based filter. 

Note: To use a selection box to select multiple elements, first select Multiple on the Options Bar. Draw 
the selection box, then click Finish on the Options Bar. 

4. Click  (Finish Selection) to save the selected elements for the filter. 

5. Click OK in the Filters dialog. 

  

 

Load a Previously Saved Selection Filter 
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To assign visibility parameters to Selection Filters 

1. Click View tab Graphics panel  (Visibility/Graphics). 

2. In the Visibility/Graphics dialog, click the Filters tab. 

3. Click Add. 

The Add Filters dialog opens, which contains a list of filters created in the project.  

4. Select a Selection Filter, and click OK. 

5. Select or clear the Visibility check box to turn visibility of the filtered object on or off. 

6. Override the Projection/Surface Lines, Patterns and/or Transparency, and Cut Lines or Patterns 
as necessary. 

7. Check the Halftone option to make filtered objects appear at halftone. 

8. Click OK or Apply to activate the filter for that view. 

 

 
 
  

 

The Filter Tab in Visibility/Graphics 
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Creating a 3D View from a Selection Set 
 

Once a Selection Set has been created, the Set can be re-loaded to make it the current selection.  The 
Selection Box tool, a new feature in Revit 2016, will allow you to create a 3D view from the selection 
elements. 

 

               

 

 

 

 

 

 

 

 

 

 

 

 

View Templates 

A View Template is a collection of view properties, such as view scale, discipline, detail level, and 
visibility settings. 

Use view templates to apply standard settings to views. View templates can help to ensure adherence to 
office standards and achieve consistency across construction document sets. 

Before creating view templates, first think about how you use views. For each type of view (floor plan, 
elevation, section, 3D view, and so on) what styles do you use? For example, an architect may use many 
styles of floor plan views, such as dimensional, life safety, demolition, furniture, and enlarged. 

You can create a view template for each style to control settings for the visibility/graphics overrides of 
categories, view scales, detail levels, graphic display options, and more. 

View Template Properties 
When a view template is created, a list of properties to include is listed.  All of the properties that are to 
be included in the view template are checked in the Include column in the View Templates dialog.  
Initially all of the properties are checked to be included.  Users can uncheck properties to not include 
them in the view template. 

 

             

Creating a 3D View from a Selection Set 



See What You Want to See in Revit 2016 

 
 11 

 

Below is a list of the properties and a description of all the properties that can be included in a View 
Template.   

View Scale Specifies the scale of the view. When you select Custom, you can edit the Scale 
Value property. 

Scale Value 1: Specifies a ratio derived from the view scale. For example, if the view scale is 
1:100, the scale value is the ratio of 100/1 or 100. You can edit this value when 
you select Custom for the View Scale property. 

Display Model Hides the model in detail view. The Normal setting displays all elements 
normally. It is intended for all non-detail views. 

The Do Not Display setting shows only detail-view–specific elements. These 
elements include lines, regions, dimensions, text, and symbols. Elements in the 
model do not display. 

The Halftone setting displays all detail-view–specific elements normally, while 
model elements display in halftone. You can use the halftone model elements as 
references for tracing lines, dimensioning, and aligning.  

Detail Level Applies the detail level setting to the view. 

Parts Visibility Specifies whether parts and the elements they were created from will display in 
views. 

V/G Overrides Model Defines visibility/graphics overrides for model categories.  

V/G Overrides 
Annotation 

Defines visibility/graphics overrides for annotation categories.  

V/G Overrides 
Analytical Model 

Defines visibility/graphics overrides for analytical model categories.  

V/G Overrides Import Click Edit to view and modify visibility options for imported categories. 

V/G Overrides Filters Defines visibility/graphics overrides for filters.  

V/G Overrides 
Worksets 

Defines visibility/graphics overrides for worksets. 

V/G Overrides Design 
Options 

Defines visibility/graphics overrides for design options.  

Model Display Defines model display options for surfaces (visual styles such as wireframe, 
hidden line, and so on), transparency, and silhouettes 

Shadows Defines shadow settings for views. 

Sketchy Lines Defines settings for sketchy lines in views.  

Lighting Defines lighting settings, including the lighting scheme, sun setting, artificial 
lights, and the amounts of sun, ambient light, and shadows.  
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Photographic 
Exposure 

For 3D views, defines exposure settings for rendering an image. 

Background For 3D views, specifies the background to display, including a sky, gradient 
colors, or an image. 

Far Clipping For elevations and sections, specify far clip plane settings. 

Underlay Orientation For floor plans and reflected ceiling plans that use an underlay, specifies whether 
the underlay displays the corresponding floor plan or reflected ceiling plan. 

For example, for a reflected ceiling plan, you can display the corresponding floor 
plan as an underlay to assist with the placement of lighting fixtures. 

View Range Defines the view range for plan views. 

Orientation Orients the project to Project North or True North.  

Phase Filter Applies the phase properties to the view. 

Discipline Determines the visibility of non-bearing walls and discipline specific annotation 
symbols. 

Color Scheme 
Location 

Specifies whether a color scheme is applied to the background or the 
foreground. 

Color Scheme Specifies a color scheme to apply to rooms, areas, spaces, or zones in the view. 

Select an existing color scheme, or create a new one. 

System Color 
Schemes 

Specifies color schemes for pipes and ducts. 

Depth Clipping Specifies depth clip plane settings for plan views.  

Rendering Settings Specifies settings to use when rendering an image of a 3D view. 

Column Symbolic 
Offset 

Specifies the offset of a beam join to a slanted structural column. This setting is 
available only when Detail Level = Coarse and Discipline = Structural or 
Coordination. 

 

Creating View Templates 
There are 3 ways to create a view template: 

 Create based on an existing view template 

 Create based on the settings of the project view 

 Create from Graphic Display Options dialog 
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To create a view template based on an existing view template 
1. Click View tab Graphics panel View Templates drop-down Manage View Templates. 

2. In the View Templates dialog, under View Templates, use the Discipline filter and the View 
type filter to limit the list of view templates.  Templates for each view type contain different 
sets of view properties. Select the appropriate view type for the template you are creating. 

3. In the Names list, select the view template to use as a starting point for the new template. 

4. Click  (Duplicate). 

5. In the New View Template 
dialog, enter a name for the 
template, and click OK.  

6. Modify view template 
property values as needed.  
The Include column allows 
you to select the properties 
that will be included in the 
view template. Clear the 
Include option to remove 
properties from the template. 
For properties that you do not 
include in the view template, 
you do not need to specify a 
value. These view properties 
will not be overridden when 
you apply the view template. 

7. Click OK. 

  

 

View Template Dialog 
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To create a view template based on the settings of a project view 
1. In the Project Browser, select the view from which you want to create the view template. 

2. Click View tab Graphics panel View Templates 
drop-down Create Template from Current View, or 
right click on the view name in the Project Browser 
and select Create View Template from View. 

3. In the New View Template dialog, enter a name for 
the template, and click OK. 

4. In the View Templates dialog, modify view template 
property values as needed. The Include column allows 
you to select the properties that will be included in 
the view template. Clear the Include option to 
remove properties. For properties that you do not 
include in the view template, you do not need to 
specify a value. These view properties will not be 
overridden when you apply the view template. 

5. Click OK. 

 

To create a view template from the Graphic Display Options dialog 
1. On the View Control Bar, click Visual Style Graphic Display Options. 

Note: The new view template will reflect the view type of the current view. 

2. In the Graphic Display Options dialog, define the options as desired. 

3. Click Save as View Template. 

4. In the New View Template dialog, enter a name for 
the template, and click OK. 

5. In the View Templates dialog, modify view template 
property values as needed.  The Include column 
allows you to select the properties that will be 
included in the view template. Clear the Include 
option to remove properties. For properties that you 
do not include in the view template, you do not 
need to specify a value. These view properties will 
not be overridden when you apply the view 
template. 

6. Click OK. 

  

 

Create View Template from View 
on the Right Click Menu 

 

Graphic Display Options Dialog 
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View Template Tips 
When crating view templates consider the following tips. 

 You may not want to include Scale and View Range. 
o The scale and view range may need to be view specific.  By not including these in the 

View Template, this ensures that the template can be used on many views of the same 
type regardless of the view scale and view range.   

 Remove out of the box view templates to avoid confusion. 
o The Revit out-of-the-box templates include several view templates that can be used.  If 

custom view templates are created, then deleting the out-of-the-box view templates 
will avoid confusion as to which one to use.   

 Create View Templates in Revit Project Template. 
o Most of the time, view templates will not change in different projects.  By creating the 

view templates in the Revit project template, the template will only have to be created 
once.   

 View Templates can be transferred from other projects by using the Transfer Project Standards. 

 
Assigning Vs. Applying View Templates 

Applying View Templates 
To apply a view template to a view, the easiest way is to simply right click on the view name in Project 
Browser and then select Apply Template Properties.  This will open the Apply View Template dialog.  
Select the desired View Template to be 
applied in the list of names.  You can use 
the view properties of another project 
view as a view template.  To do this, 
select Show Views and select the view 
name in the list.  Once the desired view 
template or view name is selected, 
select OK. 

When View Templates are applied, the 
view template properties are 
immediately applied.  However, the view 
is not linked to the view template.  The 
view can later be changed so that the 
view properties are not following the 
properties in the view template.  The 
view template must be re-applied to 
return the properties back to what is in 
the view template.   

In addition, applying view templates 
does not change the properties in the view if the view template is modified after the view template has 
been initially applied.  If changes are made to the view template, the view template must be re-applied 
to the views that are needing to be set to a view template.   

 

Show Views Option in the Apply View Template Dialog 
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Applying a View Template to All Views on a Sheet 
You can apply a view template to all views on a sheet to ensure adherence to office standards and 
achieve consistency across construction document sets.  When you apply a view template to views on a 
sheet, the view template properties are applied to the views that are currently included on the sheet.  
However, the view template is not assigned to those views, so later changes to the view template do not 
affect the views.   

A good example for needing to apply a view template to all views on a sheet would be to ensure that all 
views on the sheet use the same view scale.  A view template could be created that defines only the 
view scale.  After placing the views on the sheet, apply the view scale template and all views will now 
display using the same scale.   

To apply a view template to all views on a sheet: 

1. In the Project Browser, right-click a sheet 
view name, and click Apply View 
Template to All Views. 

2. In the Apply View Template dialog, 
under View Templates, use the Discipline 
filter and the View type filter to limit the 
list of view templates. 

3. In the Names list, select the view 
template to apply.   

You can use the view properties of 
another project view as a view template. 
To do this, select Show Views and select 
the view name in the list. 

4. Click OK. 

If any view in the sheet has an assigned 
view template, a message asks if you want to partially apply the selected template to the views.  
Click Yes to apply properties from the selected view template that are not controlled by an 
assigned view template.  Click No to exit the message and return to the Apply View Template 
dialog without applying the view template properties. 

  

 

Apply Vie Template to All Views on a Sheet 
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Assigning View Templates 
When you Assign a view template to a view, you create a link between the template and the view.  Later 
changes to the view template are automatically applied to any linked views.  You can assign a view 
template to a single view or to multiple views at one time. 

To assign a view template to views 

1. In the Project Browser, select the view or views to which you want to assign a view template. 

Note: Use the CTRL key to select multiple views in the 
Project Browser. 

2. On the Properties palette, for View Template, 
click the button in the Value column. 

3. In the Apply View Template dialog, under 
View Templates, use the Discipline filter and 
the View type filter to limit the list of view 
templates. 

4. In the Names list, select the view template to 
apply. 

You can use the view properties of another project 
view as a view template. To do this, select Show Views and select the view name in the list. 

5. Click OK. 

Notice that, on the Properties palette, the value of the View Template property has changed for each 
view, reflecting the selected view template. If the view template changes later, those changes will 
automatically be applied to these views. 

 

 

  

 

View Template Parameter in Properties 

 

View Template Parameter in Properties 
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Also notice that view properties that are controlled by the assigned view template display in gray, 
indicating that they are disabled.  

To change those values, you must do one 
of the following: 

 Change the corresponding 
property in the assigned view 
template. 

 On the Properties palette for the 
view, change the View Template 
value to <None> (or to another 
template that does not define that 
property). You can then change 
the view property as desired. 

 

Assigning View Templates to New View Types 
When new views are created in the project, a view template can be automatically assigned to those 
view types by assigning the view templates to new view types.  For example, when a section is created, a 
section view template can be assigned automatically.  This will ensure that all new views are following 
office standards as far as the view properties.   

To assign view templates to new view types 

1. Select a view in the Project Browser that is the type of view desired (floor plan, ceiling plan, 
section, elevation, etc…).   

2. In the properties, select Edit Type to open the 
Type Properties of that particular view type.   

3. In the Type Properties, for View Template 
applied to new views, click the button in the 
Value column.   

4. In the names list, select the view template to 
assign. 

5. Click OK.    

  

 

View Properties are disabled 

 

View Template applied to new views parameter 
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Another way to Assign View Templates to views is to create a View Schedule.  In a view schedule, all 
view properties can be displayed for all views.  Included in this list is the assigned view template.  The 
assigned view template for all views in the project can easily be verified or changed in a view schedule.  

 

Temporary View Properties 

If a View Template is Assigned to a view than all the view properties that are controlled by the assigned 
view template display in gray and are not able to be changed.  This is because the View Template is now 
controlling all the properties.  If the need arises to change one of the views temporarily to view the view 
with different view properties, Temporary View Properties can be enabled.  Temporary view properties 
will allow adjustments to a view but only in a temporary state.  If the model is closed and re-opened, the 
assigned view properties in the view template will be displayed.  If the view with temporary view 
properties assigned is plotted, the view will plot with the assigned view properties not the temporary 
view properties.   

This allows users to adjust the view properties while working in views but maintains the view properties 
in the view template.  Many users create duplicate views in the model- one for working in and one for 
printing.  With the use of Temporary View Properties, the duplicate views are no longer needed.  Each 
user can work in the temporary state while the view will maintain the view template properties when 
printed.   

 

 

 

 

  

 

A View List Schedule 
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To Enable Temporary View Properties, click on the 
Temporary View Properties icon on the bottom of the 
view control bar.   

The following view options are displayed to select from.   
Enable Temporary View Properties: Select to enter a 
temporary view mode. Changes made to the view 
instance properties are visible until cleared or Restore 
View Properties is selected. 

Temporarily Apply Template Properties: Opens the 
Temporarily Apply Template Properties dialog with 
which you can apply, assign, or create a view template. 

If you create a new view template, it will be added to 
the list of view templates available for the appropriate 
view type. 

Recent Templates: Displays a list of the last 5 view templates that you have used. Select one to reapply 
it to the temporary view 

Restore View Properties: Select to exit the temporary view mode and display the current project view. 

 

Other View Settings 

View Range 
One of the most difficult topics to understand (or explain) in Revit is the View Range.  If you have ever 
seen the following dialog box after trying to create something in Revit, chances are high that the 
elements you created are outside the view range.   

 

 

 

 

 

 

 

The view range is a set of horizontal planes that control the visibility and display of objects in a plan 
view. 

Every plan view has a property called View Range. The Primary Range are horizontal planes that define 
the view’s Top, Cut Plane, and Bottom. The top and bottom clip planes represent the topmost and 
bottommost portion of the view range. The cut plane is a plane that determines the height at which 
certain elements in the view are shown as cut. These 3 planes define the primary range of the view 
range. 

 

Temporary View Properties 

 

Warning Dialog 
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View depth is an additional plane beyond the primary range. Change the view depth to show elements 
below the bottom clip plane. By default, the view depth coincides with the bottom clip plane.  The view 
depth must be equal to or below the Bottom in floor plans, and equal to or above the Top in ceiling 
plans.   

Setting the View Depth below the Bottom of the Primary Range in floor plans will allow elements that 

are in between the Primary Bottom Range and the View Depth to be displayed using a Beyond linetype.   

Note:  The Beyond linetype is set to a solid linetype in all out-of-the-box project templates.  The Beyond 
linetype can be changed to a hidden linetype in the Line Styles settings on the Manage Tab.  

 

 

  

 

  

 

View Range Dialog 

Line Styles Dialog 
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The following illustrations can be used to understand what happens when there is NO view depth versus 
when there is a view depth set for both floor plans and 
ceiling plans.   

 

View Range – Floor Plan with NO View Depth 

                                            

 

 

 

  

 

View Range Dialog 

 

Floor Plan with NO View Depth 

 

Section with NO View Depth 
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View Range – Floor Plan with View Depth 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

View Range Dialog 

Floor Plan with View Depth 

Section with View Depth 
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View Range – Ceiling Plan with NO View Depth 

 

 

 

 

 

 

 

 

 

 

 

  

 

View Range Dialog 

 

Ceiling Plan with NO View Depth 

Section with NO View Depth 
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View Range – Ceiling Plan with View Depth 

  

 

View Range Dialog 

 

Ceiling Plan with View Depth 

(Ceiling set to transparent) 

 

Section with View Depth 
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Marble Challenge 

Prior to the start of Autodesk University, I sent an email with instructions to download the Marble 
Challenge.  The Marble Challenge is a training puzzle to test your abilities to control what you see in 
Revit.  The Marble Challenge is not my original creation.  I want to give credit to whoever created it, but 
I do not know where it originated.   

The object of the Marble Challenge is to modify the view properties in the Marbles Hidden view so the 
marbles are not hidden and appear the same as the Marbles Revealed view.   

Lost Marble Introduction 
This is a training puzzle that teaches users several methods of controlling the visibility of the elements in 
a Revit Project. Within the project, "Revit 2016 - Lost Marbles", there are 27 different marbles. Each of 
these marbles is obscured from view and hidden. Your task is to find and reveal each of these marbles in 
the View as instructed within the Revit project while following all of the rules listed below. Good Luck! 

Lost Marble Victory Condition 

 The "Marbles Hidden" View must match the "Marbles Revealed" View EXACTLY. 

 Not only do all of the marble have to be revealed but they must appear IDENTICAL in both 
Views. 

Lost Marble Instructions 
Unzip and place all file in the same folder. Open the file through Revit, and before clicking OPEN, check 
the box at the bottom "Detach from Central", open and then select "Detach and preserve worksets". 

Lost Marble Rules 
1. You may not MOVE, DELETE, COPY, CREATE, or otherwise modify ANY elements in ANY View. 

2. You may not CREATE, REMOVE, or MODIFY any Families or Family Types. 

3. You may not apply new visibility overrides of any kind. You may only remove, reset, or clear 
them. This includes Element Overrides, V/G Overrides, Object Styles, View Templates, Phase 
Filters, etc. 

4. You may not change ANY aspect the Main View, 3D View, or Master View in any way. 

5. You may not CHANGE the TYPE of any MODEL elements. 

6. You may not CHANGE, ADD, or APPLY any of the Materials. 

7. You may open but may not CHANGE or EDIT the linked files in ANY way. 

8. You will only need to use functions and tools from the VIEW tab.  

9. You may create new Views as you wish, but the standard rules apply. 

The following pages have the solution instructions.  Only continue reading this document if you are 
ready to see the solution. 

 

 SPOILER ALERT!!! 
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Lost Marble Solution 
To successfully solve the Lost Marble puzzle, follow the steps below. 

In the Properties Palette for the Marble Hidden View 

 Change the Display Model parameter to Normal 

 Set Detail Level to Fine 

 Change the Phase Filter to Show Complete 

 Change the View Range of the view to have a 4” Cut Plane 

 

 

 

 

 

 

 

 

 

 

  

 

Properties Palette 
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In Visibility/Graphic Settings for the Marble Hidden View 

Model Categories tab 

 Turn off the Detail Item Category  

 Turn On the Furniture, Generic Model, Mechanical Equipment categories  

 Change the Furniture category to Coarse  

 Turn on the Marble sub-category for the Generic Model category  

 Turn on the Marble sub-category for the Structural Stiffeners category  

 

 

 

 

Annotations Categories tab 

 Turn on the Generic Annotations category  

 Turn off the Mask sub-category for the Generic Annotations category  

 Turn off the Generic Model Tag category  

 

Model Categories tab 

 

Annotations Categories tab 
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Imported Categories tab 

 Turn on Marble.dwg and Layer 0 for Marble.dwg  

 

 

 

 

 

 

 

Filters tab 

 Turn on the view filter View Filter 1  

 

 

 

 

 

 

 

 

Worksets tab 

 Set Workset 2 to Use Global Setting (Visible)  

 Set Workset 3 to Show  

 Set Workset 4 to Hide  

 

 

 

  

 

Imported Categories tab 

 

Filter tab 

 

Worksets tab 
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Revit Links tab 

 Turn on the Revit link Marble.rvt  

 Set the Marble.rvt link to By Host View  

 

 

 

 

 

 

 

 

 

 

Design Options tab 

 Set Design Options to Automatic  

 

 

 

  

 

Revit Links tab 

 

Design Options tab 
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In the Marble Hidden View 

 In the Reveal Hidden Objects mode 

o Unhide hidden marble by right clicking and selecting Unhide in View / Element  

o Change the Plan Region View Range to a 4” Cut Plane 

 Turn off Crop by selecting the Do Not Crop icon 

 Hide the RasterMask.jpg raster image by using the right-click Hide in View / Elements option 

 Change the Duct System for Supply to use the Brass Material 

 Reset the Graphic Overrides on the Beige Marble 

 

Conclusion 

Revit has many tools to assist in controlling what we see in our views.  With the use of View Filters, 
View Templates, Temporary View Properties and the View Range users can customize each view to 
display differently.  Creating a workflow in projects to incorporate the use of these tools will improve 
your productivity and assist with following office standards.  The key to incorporating these tools is to 
set them up in the Revit Project Template.  This way as projects begin, views will be created with the 
appropriate view templates assigned with View Filters applied and the View Range set correctly. 

 

 

 

 

 

Marble Puzzle Solved 


